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 مقدمه
ن انجام تحلیل طیفی با نحوه مدلسازی یک قاب فولادی دو طبقه آشنا شدیم. در این مثال از همان مدل برای انجام تحلیل مودال و استخراج مشخصات مودی و همچنی AHR-05گزارش آموزشی در 

 ا اصلاحات لازم برای انجام تحلیل مودال و طیفی در آن اشاره خواهد شد. شود. به همین دلیل نحوه ساخت مدل تکرار نشده و تنهاستفاده می IIIبرای خاک نوع  2800با طیف مفروض در استاندارد 

ذخیره می  Load Case یک شود. ابتدا جرمهای متمرکز روی قاب تعریف شده سپس تحلیل ثقلی صورت گرفته و نتایج آن دراستفاده می Load Caseبرای ترکیب آثار بار ثقلی و تحلیل طیفی از 

 شوند. ا یکدیگر جمع شده و نتایج مشاهده میبقلی و طیفی ثهای Load Caseدر نهایت نتایج تحلیلی می شود. دیگری ذخیره  Load Caseشده و نتایج آن در فی انجام شود. در ادامه تحلیل طی

  

 مشخصات مدل
 نوع مدل: دو بعدی

 Beam188نوع المان: 

 نوع مصالح: الاستیک خطی

 2.1e11مدول الاستیسیته: 

 0.35ضریب پواسون: 

 kg 5000جرم متمرکز در سر ستونها: 

 Nو  kgو  mواحدها: 
 

 اهداف
 آشنایی با نحوه انجام تحلیل مودال -

 استخراج مشخصات مودی -

 انجام تحلیل طیفی -
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 اتنک
 شود:برای انجام یک تحلیل مودال لازم است از واحدهای سازگار دینامیکی استفاده گردد. در این مثال از واحدهای سازگار زیر استفاده می

 کیلوگرم برای جرم متمرکز و چگالی مصالح، -

 نیوتن برای نیروها، -

 متر برای وحدهای طولی، -

 نیوتن بر متر مربع برای مدول الاستیسیته. -
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 AHR-05بازخوانی مثال 

قرار داده شده و  fileبرابر  Jobnameمعرفی و نام  Working Directoryدر فولدر جدیدی قرار داده می شود. نام فولدر جدید در تهیه شده و  AHR-05گزارش  file.dbدر این مثال یک کپی از 

 می کنیم: Runبرنامه را 

Start → All Programs → ANSYS 17 → ANSYS Product Launcher → 

 

 

 

  

فولدر محتوی کپی از مثال با استفاده از 

 انتخاب شود. Browseدگمه 

 در نظر گرفته می شود.  fileام مدل ن
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 تعریف جرمها
برای  Densityبرای تعریف چگالی وارد بخش مصالح شده و گزینه گیرد. تعریف جرم به دو صورت چگالی مصالح برای المانهای تیر و ستون و جرمهای متمرکز به عنوان نماینده جرم طبقه صورت می

 شود.کیلوگرم بر متر مکعب قرار داده می 7850الح قاب را انتخاب نمائید. مقدار چگالی برابر مص

 

 شروع 
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 میشود: در آدرس زیر انتخاب  Elements Typeشود. ابتدا نوع المان در بخش استفاده می MASS21از المان  ،برای تعیین جرم متمرکز نماینده جرم طبقه

 

 شروع 
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شود. این المان قابلیت شبیه سازی شش مؤلفه جرمی بصورت جرمهای متمرکز در سه جهت اصلی و اینرسی دورانی حول سه محور تعریف می Real Constantبا استفاده از  Mass21مقدار جرم المان 

قدار ــــــــتعریف شده و م Mass21برای المان  Real Constantجدید از  setورود به آدرس زیر یک شود. با استفاده می Xاصلی را داراست. در این مثال تنها از گزینه جرم متمرکز در جهت محور 

Mass in X Direction  شود. کیلوگرم قرار داده می 5000برابر 

 

 شروع 
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 روی گره های سر ستونها Massقرار دادن المان 
نیازی به تعریف  Massالمان شوند. در آدرس زیر مشخص می Real Constantتعریف شده برای  شمارهدر گره های سر ستونها ابتدا مشخصات المان شامل نوع المان و  Massبرای تعریف المانهای 

 مصالح ندارد.

 

 شروع 
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 Elements from Nodesرا در پنجره  Applyشود. وارد بخش زیر شده و با فعال شدن موس ابتدا روی گره بالای ستون سمت چپ کلیک کرده و دگمه ها قرار داده میبر روی گره Massحال المان  

کیلوگرم در بالای ستونها قرار  5000با جرم  Massرا فشار دهید. به این ترتیب المانهای  Elements from Nodesپنجره  Okفشار دهید. مجدداً روی گره بالای ستون سمت راست کلیک کرده و دگمه 

  .شوندمیداده 
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 شود. برای بازنمایش گرافیکی المانها از آدرس زیر استفاده نمائید:های کوچکی روی مدل دیده می، موقعیت آنها بصورت ستارهMassپس از تعریف المانهای 

Plot → Replot 
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 تعریف طبقه صلب
های سر ستونها از طریق گره xشوند. برای این منظور درجه آزادی جهت های فوقانی ستونها بوسیله یک دیافراگم صلب به یکدیگر متصل میهای قابی که دارای سقف صلب هستند، گرهدر سازه

Coupling شوند.  با باز شدن پنجره در آدرس زیر به یکدیگر مقید میDefine Coupling DOFsشود. حال روی گره های سر ستون اول و دوم کلیک کرده و دگمه ، موس فعال میOk  .را فشار دهید 
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 را فشار دهید. Okرا انتخاب کرده  و  Uxگزینه  Labرا وارد و در  1عدد  NSETدر پنجره دوم در مقابل 
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 تحلیل ثقلی
 شود: با استفاده از دستور زیر حذف میدر مدل قاب یک بار متمرکز جانبی بر روی طبقه تعریف شده است. این بار متمرکز 
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 وارد می شود. zدر جهت  9.81برابر  2بر ثانیه به توان شود. شتاب ثقل بر حسب متر نیز مطابق با آدرس زیر تعریف میشتاب ثقل  اینک
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 در این مرحله مدل را ذخیره کنید.
                          File → Save as Jobname  

 

 گیرد. تحلیل ثقلی در آدرس زیر صورت می

                                                                                             Main Menu → Solution → Solve → Current LS  
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 Load Caseبرای  1شماره  LCNOدر مقابل  .گیردصورت می زیردر آدرس  شود. این عملذخیره می Load Case یک برای ترکیب نتایج تحلیل ثقلی و طیفی، پس از انجام تحلیل ثقلی نتایج آن در

و دارای  چون تحلیل ثقلی تنها یک فایل بارگذاریذخیره شود.   Load Caseگامی است که می خواهیم نتایج آن در وارد می شود که نشاندهنده  1 نیز اعداد SBSTEPو  LSTEPشود. برای وارد می

  شوند.قرار داده می 1این اعداد برابر  بوده است، Sub stepفقط یک 

 

 شروع 
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 شود. ذخیره می Gravity.txtفایل با نام ( برای بازیابی بعدی در یک Load Case 1) LC1حال نتایج  
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 ترسیم نمودار لنگر حاصل از بار ثقلی
ایم برای بازنمایش نمودار لنگر لازم آشنا شده AHR-05قاب دو بعدی در گزارش در مثال  Sequence Numberشود. قبلاً با روش برای مقایسه بعدی نمودار لنگر المانها در اثر بار ثقلی ترسیم می

  تعریف شده بروزرسانی شوند: Element Tableاست ابتدا مقادیر 
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 است. SMISCفاقد کدهای  MASS21در حین انجام اینکار خطای زیر دیده می شود. دلیل این خطای آن است که المان 
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  شود:در آدرس زیر ترسیم می رودار لنگمحال ن
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 تنها ثقلینمودار لنگر المانها در اثر بار 
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 تحلیل مودال
 شود. انتخاب می  Modalبرای انجام تحلیل مودال، نوع تحلیل در آدرس زیر 
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 شود.می Okشوند. پنجره دوم فقط سایر گزینه ها مطابق تصویر زیر انتخاب میانتخاب شده است.  5شود. تعداد مودها برابر تعداد مودهای مورد نیاز برای تحلیل مشخص می Analysis Optionsحال در 
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 شود.قرار داده می %5شود. مقدار نسبت میرایی برابر میرایی مودی در آدرس زیر تعریف می
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 شود.انتخاب می out.txtگیرد. نام فایل خروجی خروجی برنامه در یک فایل دلخواه ذخیره شود. اینکار در آدرس زیر صورت می، لازم است قبل از تحلیل ،مدل از برنامهبرای دریافت مشخصات مودی 
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 انجام تحلیل
 با ورود به آدرس زیر تحلیل را انجام دهید:

Solution > Solve > Current LS 
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 استخراج مشخصات مودی
مدل است، اطلاعات مودال شامل  Working Directoryذخیره شده، مشخصات مودی مدل داخل آن نوشته شده است. با باز کردن این فایل که داخل  out.txtاز آنجائیکه خروجی برنامه در فایل 

شوند. از انجائیکه مدل سه محور اصلی مشاهده میفرکانس )بر حسب هرتز(، پریود، ضریب مشارکت مودی و نسبت آن، جرم مؤثر مودی و نسبت آن و جرم مودی تجمعی برای سه جهت اصلی مدل و حول 

 رکت جانبی طبقه بوده و بیشترین پریود و جرم مؤثر مودی را داراست.مورد نظر یک سازه یک طبقه و دو بعدی است، مود اول آن شامل ح
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 مشاهده تغییر شکل مود اول
 به حافظه فراخوانده شود.  First Setشود. ابتدا لازم است اطلاعات مود اول یا استفاده می General Post Processingبرای مشاهده تغییر شکل مود اول از بخش 
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 را انتخاب نمائید Def+Undef edgeشود. برای ترسیم تغییر شکل گزینه مراحل زیر برای ترسیم تغییر شکل مود اول دنبال می
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 تحلیل طیفی
 را انتخاب نمائید.  Spectrumگزینه  New Analysisدر بخش 
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شود. تعداد مودهای تحلیل طیفی انتخاب می Single- pt respتواند بصورت تک نقطه ای یا چند نقطه ای صورت گیرد که در اینجا طیفی می شود. تحلیلنوع تحلیل طیفی در پنجره زیر انتخاب می

 شود تا نتایج تحلیلی المانها حین تحلیل طیفی ذخیره شود. فعال می Calculate Elem Stressesعدد و گزینه  1
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و  1برابر  SEDاست که عدد متناظر آن در بخش  xو جهت وارد شدن در جهت  1شتاب، مقیاس آن  شود. نوع طیفر آدرس زیر مشخص میب آن و جهت وارد شدن طیف بر مدل دنوع طیف، ضری

  شود.سایر اعداد صفر قرار داده می
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 اند. جدول و نمودار مقادیر طیفی به شکل زیر است:و خطر نسبی خیلی زیاد استخراج شده IIIایران و برای خاک نوع  2800مقادیر طیف از استاندارد 
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 شود. برای وارد کردن طیف ابتدا مقادیر فرکانسها بر حسب هرتز در آدرس زیر وارد می

 

 شروع 

 

http://www.ansyshelp.ir/


 تحلیل مودال و طیفی یک قاب یک طبقه دو بعدی فولادی

35 ANSYS Help.ir 

در نظر  0.05تعیین شود. این مقدار برابر  Spectrum Values-Damping Ratioشوند. در این بخش ابتدا لازم است درصد میرایی طیف در پنجره سپس مقادیر طیفی متناظر در آدرس زیر وارد می

 شوند.باز شده و مقادیر طیفی بر حسب فرکانس مشخص شده با واحد متر بر ثانیه به توان دو وارد می Spectrum Valuesپنجره  Okبا زدن شود. گرفته می
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 در این مرحله مدل را ذخیره کنید.
File → Save as Jobname  

 طیفیتحلیل 
 مدل را تحلیل کنید.  Solveبا انتخاب گزینه 

Main Menu → Solution → Solve → Current LS 
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 بسط مودها
 برای اینکار ابتدا لازم است نوع تحلیل مودال شود:تحلیل طیفی مطابق راهنمای برنامه لازم است مودهای مورد نیاز در محاسبه پاسخ سازه بسط داده شوند.  تکمیلبرای 
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 اینکار در آدرس زیر انجام می شود.فعال شود.  Expansion passگزینه سپس 
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 شود. انتخاب می Yesبرابر  Calculate Element Resultsقرار داده شده و گزینه  1گیرد. تعداد مودها برابر مودهای لازم جهت ترکیب مودی پاسخها در آدرس زیر صورت میتعیین تعداد 
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 گیرد:حال مجددا تحلیل صورت می

Main Menu → Solution → Solve → Current LS 
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 تحلیل طیفیانجام مجدد 
 شود:در آدرس زیر انتخاب می طیفیشود. ابتدا تحلیل در این مرحله روش ترکیب نتایج مودی نیز انتخاب میصورت گیرد. طیفی  مطابق با راهنمای برنامه لازم است مجدداً تحلیل

Main Menu → Solution → Analysis Type → New Analysis → Spectrum 

 شوند:مطابق پنجره زیر در آدرس مربوطه مشخص میهای تحلیل طیفی داده
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  شود:( در آدرس زیر انتخاب میCQCحال روش ترکیب مودها )در اینجا 
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 شود. با انجام تحلیل مجدد، نتایج مودی با یکدیگر ترکیب می

Main Menu → Solution → Solve → Current LS 

 ساخته می شود که در محل بعد مورد استفاده قرار میگیرد.  Working Directoryدر  File.MCOMدر  این مرحله یک فایل به نام 
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 بازخوانی نتایج ترکیب طیفی مودها
واندن این دستورات ابتدا وارد بخش برای خباید خوانده شود.  General Postprocکه در بخش  شوندذخیره می file.MCOMدستورات لازم برای ترکیب نتایج مودها در روش طیفی در فایلی به نام 

 زیر شوید:
Main Menu → General Postproc  

 را بخوانید: file.MCOMحال وارد آدرس زیر شده و فایل
Utilty Menu → File → Read input from…  

  شوند.به این ترتیب نتایج در نرم افزار خوانده می
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 ترسیم نمودار لنگر حاصل از تحلیل طیفی
 می شود: تعریف شده بروزرسانی Element Tableمقادیر شود. ابتدا حاصل از تحلیل طیفی با همان روشی که برای بار ثقلی بیان شد ترسیم مینمودار لنگر المانها 
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 شود:سپس با گزینه زیر نمودار لنگر ترسیم می

Main Menu → General Postproc → Plot Results → Line Elem Res 
 شوند.نتایج تنها با علامت مثبت نشان داده میتحلیل طیفی نتیجه حاصله به شکل زیر است. دقت داشته باشید که در 

 

 نمودار لنگر المانها حاصل از تحلیل طیفی
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 Load Caseذخیره نتایج تحلیل طیفی در 
 شود. استفاده می Load Case 1برای ذخیره نتایج تحلیل طیفی در  برای ذخیره نتایج تحلیل ثقلی معرفی شد، در اینجا نیز Load Caseهمانند روشی که در ساخت 

 وارد می شوند.  1نیز اعداد  SBSTEPو  LSTEPبرای  شود.وارد می  Load Caseبرای  1شماره  LCNOدر مقابل 
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 شود. ذخیره می Spectral.txtفایل با نام بعدی در یک  ( برای بازیابیLoad Case 1) LC1حال نتایج 
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 ترکیب نتایج تحلیل ثقلی و طیفی
برای انتخاب فایل  Create Load Case from Load Case Fileدر پنجره  Browseشود. برای این منظور از دگمه ذخیره می LC2فراخوانی شده و در  Gravity.txtابتدا نتایج تحلیل ثقلی از فایل 

Gravity.txt  درWorking Directory .استفاده نمائید  
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از حافظه فراخوانی  LC1ابتدا  LCوجود دارند که در اولی نتایج تحلیل طیفی و در دومی نتایج تحلیل ثقلی ذخیره شده است. برای ترکیب نتایج این دو  Load Caseبه این ترتیب هم اکنون دو 

 شود:می
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  شود:جمع می LC1با  LC2حال 
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 Element Tableشود. توجه داشته باشید که برای مشاهده نتایج از طریق نتایج ذخیره شده در حافظه حاصل جمع تحلیل طیفی و ثقلی است. برای مشاهده نتایج از روشهای متداول استفاده می اکنون

 شوند.  Updateلازم است مقادیر آن در هر مرحله 
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 ترسیم نمودار لنگر حاصل از بار طیفی تنها
 شود:به عنوان نتیجه نهایی نمودار لنگر المانها تحت بارگذاری ترکیبی ثقلی و طیفی با روش ذکر شده قبلی ترسیم می

 
 + ثقلیبار طیفیترکیب نمودار لنگر المانها در اثر 

 در پایان مدل را ذخیره کنید. 
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